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B CETN, 20X Ta s Ry 7 A3 2 DHOEFRIIFRRINERTA,
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73 5HE. XA UORKICEITE L, BEARER T e —T 4 TSN UADEE, XA D
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VENRHY FET, ZOXL U, YNV arTRA N, vAF arTXFA MBIV AT
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[Device Information] X1 > (21 ~=X—7)

2

[Interface Status] <A1 > (22 X—)

[VPN Sessions] <A1 > (23 ~<X—)

[Traffic Status] 2+ (23 *X—2)

[System Resources Status] 31 > (23 ~X—73)

[Traffic Status] 2+ > (23 *X—2)

Device List (14 ~=—73)

[Latest ASDM Syslog Messages] <1 > (23 ~<X—)

[Device Information] X1 >

[Device Information] ™~ > 121X,

[General] # 7" & [License] % 7 &\ ) T /34 ZIEW AR RT D

20D TNRBHY £3, [General] ¥ 7 TliL, v AT L~ JLAR—H T 5 [Environment Status]
RAANT I EATEET,

[General] # 7

ZOZTITNE. ASA IZBET D IRDERFERPEF RS NET,
* [Host name] : 7 /XA ADKRA M EFRLET,

* [ASAversion] : 73 A ETFEITSNTWNDASAY 7 b =T DONR—=VarzZrLET,

* [ASDMyversion] : 7 /3NA A L TERITENTWVWHASDM Y 7 v =7 D=V a U EFR L

£,

« [Firewall mode] : 7 /3 ANFEITENTNWE T 7 A T U4 —/L T— FEFRLET,
« [Total flash] : FAEMEH STV 5D RAM DA 2R R LET,

« [ASA ClusterRole] : 7 T A XV L IRAOHEAIT, Z0MEEDO O —/L (v AX —F 121
AL—7) BRRLET,

s [Device uptime] : KZIZY 7 b =T 2T v 7 r—RKLTHhbH,

Rl 2 R L9,
s [Context mode] : 7 /NA ANFATINTNDHIALTHARN E—RERRLET,

TNA ZREEL TV D

s [Total Memory] : ASA {24 > A h—/LEZL T\ 5 DRAM ZFEKR L ET,

* [Environment status] :

VAT I~V AEFRRLET, [General] ¥ 7 @ [Environment Status]

EWVS TNV D DT T Ay (+) 227 Vv 7 LT, "= FU =T HiHE#a R
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—#%\Z. [EnvironmentStatus] R ¥ > TY AT LA ~NLVAN—H THONY £, VAT LHND
T H—HBEOTRTON— R =7 2 R—F FDIEFE RFHANTEEL T\ 58
G T AR () REATF[OK] BETERENNET, —FH, N—Ku=T VAT
LD R—=F 2 FR 1 DTHIEFERH#HFSNTEEL TWLEEIT. 77 Ris ()
REZUBFRODIN IR S>TI VT 4 AN AT —H A% R_ L, N—RU =7 aR—F
ML CITICRBMETHL Z 2R LET,

BEDA— K'Y= 7 OFEHTBICET 53OV T, 207 X0 [A— Ky =7
WA K] EBRLTES

GE) BV U—ADASAILT v 77 L—RTDHIIEAE I BPAE L TODHEAIL, [Memory
Insufficient Warning] A 7 2 7R v 7 ANKREINE T, ZOXA T TRy 7 AR REN
HIRICHE S T, AR — F &N TWAD SETASA B L OVASDM Zflk#i L CHEA L £, [OK]
O Uw I LT, ZOFATal Ry 7 AR CET,

[License] 2 T

ZOZATITNE, TA ' AR @%ft/bﬁ%ﬁéﬂiﬁoﬁ%ﬁ?%tyxﬁﬁmﬁii
I LWT 77 4 _—v 3 F—D AN EITHIZIE, [More Licenses] 27 V v 7 L ¥ 7,
[Configuration] > [Device Management] > [Licensing] > [Activation Key] A U BERIRINET,

[Cluster] & T

ZDETNE, 7 TRIDA L F =T 2 A AF— FBI W TAZDRAT —F ANFIRSNE
EE

Device Information

| General License

Cluster Interface Mode: Spanned EtherChannel

Cluster is not enabled.

Details

[Virtual Resources] ¥ 7 (ASAv)

ZDXR I, ASARIBIC L o TIHFEH SN TWARMAY YV —ARERINET, vCPUDEL,
RAM. ASA IR O u by a = VOBARENEENET,

[Interface Status] N1 >

ZORL AT, BAVE =T 2 ADAT—=HARNERENET, f X —T A ADT%
BIRT DL, ANBIOH I AL—T" 82 Kbps BAL TT —7 VD FIZFERSNET,
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[VPN Sessions] X1 >

ZDORAUNTIE, VPN b )b AT —Z ANFRENFET, [Details] 227V v 735 L.
[Monitoring] > [VPN] > [VPN Statistics] > [Sessions] XA I #E L £7,

[Failover Status] N1 >
O NTIE, T F—N— AT Z ANRFEIREINET,

[Configure] &2~ Y =2 LT, High Availability and Scalability Wizard Z &8 L £3, Z D7 1 HF—
REFZETTDHE, 7=2—NAA—N"—arT7 s Fal—a AT —HA ([Active/Active] 7=
I [Active/Standby]) AAERIAILET,

T 2= VA= R=EREINTWBEHEL, [Details] #7 U 7 9% & [Monitoring] > [Properties]
> [Failover] > [Status] ~<A > 3B & 97,

[System Resources Status] N1 >
Z DA i, CPUB LA EY O RIS T 2 EHER PR R S E T

[Traffic Status] X1 >

TN UNE, A F—T = A ARG & kb EBENVEX 2V T4 A F—T =
AADNT T 4T AN—T v hDT T ITNFERENET,

AT 4 F 2L =gl EFa T4 LoULRE LIRS V=T o ADEREENTE
D, ZONTIOL4FIN Toutside] THHLGH. TDA L H—T A ANKNT T 47 A
N—T"> NOT T 7R ENET, ZNLNOEE, ASDMiZtEXx2 VT 4 LNVRED
BnWA > H—T 2 A ADTNVT 7 Xy MEDY A ML ERHIOA »H—T7 =4 A% BRI
7

[Latest ASDM Syslog Messages] N1 >

TS NTIE, ASADERR LTEHRFIOS AT A A v =R 100 HETHRRENET, &
X TINT 4 B—T NI o TV AHYA L, [Enable Logging] #7 Y v 7 LTA F—7/MZ L
7,

WDORIZ, [Latest ASDM Syslog Messages] ~XA > DHEFZZ R L ET,

3: [Latest ASDM Syslog Messages] X1 >

o @?@?

Latest ASDM Syshog Messages Og ? =
Severty | Dabe Time Swskog ID | Source IP Source Dastnabion IP  Dastind Dascripion

L7-54:47 302021 he:-214:5a... 0 Fhazi<1 g Tanr WP connaction For faddr fead:

¥ LTSS 300020 FeSin=214:5aff... O FRaz:zl o it inbeoung] J0MP conreection For Fadde FeBc2

g 17R442 M2021 Pl =208 Feffr.. @ Fraz:sl ) Teardown ICMP connection For Faddr Felt: 200
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RA DOV A REERETHITE, TANA T2 EEREIFICRT v 7 LET,

2

NAUERBBALET, AU ETFT TN ROV A RCETICIE. ZEDQEARO
TAaryx2r )y 7 LET,

Ta—T AT EERLET, XA E Ry X5, Fydoyd
LtsRAVTA w277 LET,

HEWER REA F—T NV ERET =7 LEd, HEFEERNA 2 —7 1
2 AE, £ THEIZ & % [Latest ASDM Syslog Messages] 82 > @D B2 — Y V%
BEIT DL, A VRRRENET, D=V NEXA VInbRET L A 139
FRIZRD £,

NAVERALET, XA U EFRTHITIX, [View Latest ASDM Syslog Messages]
EEINLET,

FHNZH DT A 2% v 735 &, syslog A v t—YDFEROFTH %
TLET,

FNZHDFRWNT A 227 )y 73 5L, syslog A vE—YDORROEH 215
A'J:]\/ij—o

FHZoHDTA4NE T A% 7 Uy 273 5L, [Logging Filters] ~<A1 A3 & &
_a—o

e AR &V Y v LT [ClearContent] #3#&IRT 5 &, BEDRA v —TEHEELET,

e AR NEHZY v LT [SaveContent] %7 U v 7§65 &, BITEOA v&—T%PC ED
77 A MTRIFLET,

AN &L Y v 7 LT [Copy] ZIRT D&, BITEONEZaE—LET,

e A X NEHZ Y v LT[ColorSettings] # 4RI 5L, v ETT 4 (EKE) (ZFES0
Tsyslog A v bE—VOBFRALATRATEELET,

[Firewall Dashhoard] % 7

[Firewall Dashboard] % 7 Tl&, ASA%EiHT 5 N7 7 4 v 7 IZHT 2 HERIEREZ MR TX E
T, ZOX v vaR—KiE, Yo/ aryFANE—FRNELEFvALF aryTEFANE—F
DELLTHLINTL VR EF, wTF a7 F A b £— NTiX, [Firewall Dashboard]
FEa T HFA MRICERRTEET,

Yj’(@@l\

[Firewall Dashboard] # 7 D F# D —#i % /k L £,
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[Traffic Overview] XA > .

4: [Firewall Dashboard] 2 7

# Cizem A%DM 6.3 for ASA - 10 B8 54 BE

:l Jll'h..‘.'....-......“ -
';3.@- R A A s s
| et | (W PRl Eeseye B "
T .-_qi |
) .. II .IH" .I._ql. _H_ .Il
1| FEEEI L | — -l b W
A Pl B e e . m-.
Bl Brore oo B bl B [ a0 Songeom | Voo L Conimaties | s LY L B
L r1l | Il Fnmdon (L
| pa | oes £y f
.| -_‘- lh.—l. 'l-ﬂ._‘. 'I-‘} '.-_-
S e T e ]
- £ = ] Iﬂﬁmuaihﬁmwﬁ
R
GUI Ex% HL:L
1 [Traffic Overview] <A1 > (25 _—7)
2 [Top 10 Access Rules] <1 > (26 ~=*—3)
3 [Top Usage Status] %A1 > (26 ~<—2)

(#£7~72 L) |[Top Ten Protected Servers Under SYN Attack] X1 > (27 =—7)

(F/R72 L) |[Top 200 Hosts] ~3A > (27 ~2—7)

(7”72 L) |[Top Botnet Traffic Filter Hits] ~X1 > (27 ~X—2)

[Traffic Overview] XA >

T AN ETE AFX—=TNVTE, BAGBHREET 4 =7 T oL (7747 V4 —
NWORRFETA K] Z2Z8) | Z OFERIZIL [Enable] RN ¥ 3 F RSV E T, [Enable] R ¥ %
EH L CEAEBREE T =7 M TEET, FETROMEHMERITIE, RRFHORDE
WBREENET,

o BEfTEL & NAT Z5H1,
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. [Top 10 Access Rules] X1 >

e TR VANMIIDBEERBIOT YV r—va v A AT a il TRay”
Ny R,

s Ky Ty N, Thiud, Ax v VU HBO—HE L TRESNDIGE L. REE
v iart LTHHINEES (TCPSYN KERLF— 472 L UDP v a WS
BMELIESRERE) B’ £,

[Top 10 Access Rules] X1 >

FI AN NTIE. A F—TNTT, TZ A NL—LOEBBREEHESREYT + E—T T 5
E (774704 —NORETA R 258) | Z OFKIZIL [Enable] RN U BERRZIVE
¥, [Enable] R¥ L & LTT 7t A L—LOFEHERE AN TEET,

T=T N Ea—TiE, VAMROA—AEZRIRLTHEHZ Vv 7L, Ry T T v 7 A=a—I
H @ [ShowRule] # X R TEFEF, ZOHHEZEINL T [Access Rules] 7— 7 /LICBEI L, 7—
TARNZHDHEDNL—VERIRLET,

[Top Usage Status] X1 >
FIHNETIE, TAE—=TNATT, 2O, 2T, RO 4ODEZTHRHY £F,
* [Top 10 Services] : &R H ¥ — B A
* [Top 10 Sources] : & BRI+ — B 2
* [Top 10 Destinations] : & @ HiH— & &

«[Topl0Users] : 7AT T 474 77 AT Ut —/L F—ER

w®AD 3 >DH 7 ([Top 10 Services], [Top 10 Sources], 35 & O¥ [Top 10 Destinations]) T, &
B Y — B RICEAT A FGEHER AR L E T, &4 7 IE. ENENOEBMRE— v 2%
AR —=TMZT 2 [Enable] RZ 3V E£T, [T7 AT U —NVOREHTA R 19> T,
INLEAEDITEET,

[Top 10 Services Enable] R¥ & FEHT 5L, R— b &7va b a Lol FOMHERE A F—
TR FET (EHBLRFAICA =T T HRENRH Y £9) . [Top 10 Sources] 1 4
> ¥ J OV [Top 10 Destinations Enable] 78 &% > 325 & | R A b OFEHERD A R —7 T

70 ET, FAL EEILBLO%E) O IEHAT—2 ZAHEHER, BLOKR— K& nm
FaANRRINET,

4FHDH T [Top 10 Users] Tk, TAT T AT 4 7747 U —/ —E X Dt
WA LT TAF o T 4T 4 T 7 AT U A e AT, 2P DT A F o
TATALESLT 72 avbe—naRftLEd, BMEILXIPT FLATEAR 2—F—
4k =P TN TR ESNTT 72 A=A e F a2 VT 4 K — 2 BETEET,
ASAIE, IP La—HF—Dv o B2 ) F—HR=AIT VAL T, ZOP—EAZRHELE
T

[Top 10 Users] % 71X, OWTNMNEFRELIZGAEDHR, T—XEFKRLET,

« Identity Firewall +— B2 =327 ¢ ¥ 2 L— 3 =3 > : Microsoft Active Directory 35 J2 T8 Cisco
ActiveDirectory (AD) =— =V DEBIMa L R—3 2 NOFRTEE G H»F T, Identity Firewall

B ASMSS T4 AL aA—H—A28—T(R
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[Top Ten Protected Servers Under SYN Attack] ~ - > .

P— B RL, user-identity enable =~ K (77 %/ F TH%H) I LT user-accounting
statistics =~ > N2 fE L Tk s E T,

¢ VPN = —W—DBFE, RBATEIEXT IV T 4 7 %247 H 72912 RADIUS H—/X—%fif
HATAVPNaL 7 4 Fal— g,

BIR L7247 3 G U, [Top 10 Users] # 712, BN 10 22— — D55 L7z EPS /X7
b EELZEPS Ny b BROEE SN HBICET HHGHERN R RSN ET,

(domainwuser_name & L TR IND) Fax—HF—ICBAL T, Zo¥72iL, 20— —0
VHJEPS 3w b BUEDEPS N7 v b MU T —, BLOGEA N MR FERENET,

A

FE

cll

JEERGHEMEZ AT D &, AT DMEHEFMDO Z A TS LT, ASAD/NRT —~v A
NBEZTET, RANOFEFHEREZA XF—TMIT D E, T p—< L AR IR EEN
bVET, NTT 4 v OARMBEWEGEEIL. 20X A T OFEHERIZT R A R—T LI
THIEERFL TS, 2L, K= FOFFHEREZ A x—7 ML TH, THIEEFE
EIH Y FHA,

[Top Ten Protected Servers Under SYN Attack] N1 >

T7 4N NTIE, T48—7NTT, ZOMEKRIZE RS TS [Enable] R ¥ 2 LT,
COMREEANCTEET, FE. (7747 U+ —VRETA ] 2> THEMIZT S Z
EHTEET, WBEZIT RSN BAZ 10 = —DHEHERP B RINET,

FEHEL— FOBE. ASAITLV— MR (7740 MI30%53) LTI I LT —4
YTV T LET,

BEOBEE NN DLEAE1T. [<various>] DRICEBZDOKEZDIP T RLANERINE T,

[Detail] 7 UV v 7 LT, 10 BDH—_"—721F T, TXTOH— 13— (JKK10005E) DO
FEmAEFR R LUET, BEY ) S F— A BT D &%T%i¢<MAiV—FW
WEORNCHBOHK % 60RIY- > 7Y > 7T 50T, 7740 bO 305 TIE, 60T &2kt
FHERBIE SN E T,

[Top 200 Hosts] N1 >

T 7 ANV ETIHE, T48—T7 A TT, ASAZI L CHERET D EL200 DR A N EFRRLET,
BRAFOFKT MU, Txb®m7%v2& HRA ML > TRt SN OB &
Fh, 2O RV ROV TECT v I T bENET, TOERREA XTI NVITTDHITIE
hpm topnenable =~ > K& AL £7,

[Top Botnet Traffic Filter Hits] <X >

T7HNITIH, T4B=T7ATYT, ZOERIIIE, Ny b2y b NG 7497 T4 08 %
RETDHEOD) I NEENTHET, 2 I10HORy hxy b %14 b, F—F, BLD
PR A PO UR— NI, T—=FDAF v Fay FaREL, HEHEROUIERMBLED
MI0EBIZ—HLEWGEERHVET, IPT FLRAEZEZ U v 735 L, whois Y — /LN E
FHLTRy b2y N A FOFEHBRTRRINET,
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. [Cluster Dashhoard] % J

FEHZOWTIE, TRy bxy

[Cluster Dashboard] 2 7

FRETA R 2R LTI IZE0,

ASA 7 FAZ Y U T A R—=T ML T, vAX— 2=y MNIEH L T 555 1%, [Cluster
Dashboard] # 727 T AX DAL=y 7L ) Y —AFHROMENEREINE T,

Home

Device Name ‘ Management IP Address Role

Version ‘ Uptime

Bl el Dacooad,

Resource Utilization
CPU Used Memary

Environment Status |Hulrh Status

clsl 172.23.204.243

2001:b0b:6500::3

MASTER

Average CPU Usage (percent)
: g

2

1%

v

0&:10

18:-11.0: Da-07 08:08 08:09

Overall Memory Usage (MB)

: W st it
450
400
350

300

2

250
00
150
100

50

18:11:0° D07 0808 05:09 0&:10

100.8(0.94) 2d 15h 56m 495

Connections Per Second

~Cluster Owverall

? FAIL

? Unknown [ 1% BESEE94 MB

Throughput Load Balancing P_]

~Per=-Member Total

0807 0808
WMUDP: 0 ETCP O M Total: 0

08:11

0807
W cisl: O

08:08 0809

[T

« [Cluster Members] : 7 7 A X ZHEKT D A L R—DLRTEFERFER (FEIP 7 LR,
N=Vay, JTALRADE—ARE) BEORALNSR—DNVA AT =4 A (BEEAT —

B A ANVAR AT —H A

BLOY Y =R 2RRLET,
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Y

[Cluster Firewall Dashboard] % ' .

G¥)

<NVF arTFXFARET—RTIE, BHaUTXA M ASDM %
B, WIZHOarT7F A MIEELTH, UAMRRINT
WAEHIP 7 FLRAFHED L THF A MOEFIP 7 KL R
EHREINFETA, ASDMPBIEHERG SN TND AL 7 TAXD
IP7 RLAZGHERa L TXXANOBEHIP T FL A%, §l&
FEFR BT ET,

* [System Resource Status] : 7 7 AZ R{RD Y VYV —2ffiffj= (CPUB LU AEY) & 7
T4 I DTTT (VIFAZBEBLOT A RATE) ZRRLET,

s [Traffic Status] : &% 7ZIZRD T Z7 703 H 0 7,

* [Connections Per Second] % 7
[Cluster Overal] : 7 7 A X RO B O PR RINET,
[Per-Member Total] : £ A > /S — D BAL O FIJFEHEF N KR SILE T
s [Throughput] % 7
[Cluster Overall] : 7 7 A X &R TIAN—T"> FPRREINET,

[Per-Member Throughput] : A > /N—D A )L—"T" "M, AL N—=T L2 1173 20FR
SNET,

» [Load Balancing] % 7

[Per-Member Percentage of Total Traffic] : A ' N—MNZ(E LRI TAX N T T 4w 7
DFENG, A N=T LR RINET,

[Per-Member Locally Processed Traffic] : ©—# /WZALEES 7= T 7 4 v 7 OEIGD,
AUN=T IR RENET,

* [Control Link Usage] % 7
[Per-Member Receival Capacity Utilization] : Z5E R EDOMEHFEN, A =T L ITRR
SNET,

[Per-Member Transmittal Capacity Utilization] : SZ{E R RO, A =T LTk
RENET,

[Cluster Firewall Dashboard] 2 7

[Cluster Firewall Dashboard] # 7'(Z1%, [Firewall Dashboard] {(Z#E /R INAIEREFRED T 7 4
7 OERL L TtopN) FEHERDBFRINE TN, 7 7 AXBRICOEDFHIE RSN E

A,

ASDM 5524 AL a—4—1v4—7z42 ||



ASDM 5574 AL 1—4—Av8—Tx4Z |

. [Content Security] 2 '

Connection Statistics

Interval: Last 1 hour =  Based on: Packet HitsDisplay: Tab

4
3

2

The Top 10 Access Rules feature is disabled in the Security Appli
1 Please click the button to enable it.

|- Enable |

- ' i -
0&:.07 03,08 0809 DE:1D 0&:11

M Connections: 1 M NAT Xlates: 0
Dropped Packets Rate

The Dropped Packets Rate feature is disabled
in the Security Appliance.
Please click the button to enable it.

Top 10 Services i Top 10 Sources >

Interval: Last 1 hour - Based on: Packet Hits 5 [

Possible Scan and 5YN Attack Rates

The Possible Scan and SYN Attack Rates
feature is disabled in the Security Appliance.
Please click the button to enable it.

The Top 10 Services feature is disabled in the Securi
Please click the button to enable it.

| Enable_| ofnhle,

[Content Security] & 7

[Content Security] & 7 Cl%, CSC (Content Security and Control) SSM (Z B3 % B 272 1t % fife
RTEET, T, E, CSCSSMTEMEL TWNDHCSCY 7 M7 =7 R ASAIZA A b—
NENTVDBEDHFRENET,

A

()  [Configuration] > [Trend Micro Content Security] > [CSC Setup] % 4R L C CSC Setup Wizard % 52
T LTWRu & | [Home] > [Content Security] D FIZ&HH A AT 7 BATEEHA, DY
WCHAT TRy I ARERRII, O L CSCSetupWizard IZEHET 7 EATEET,

WD, [Content Security] ¥ 7 DEF &~ L £9,
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5: [Content Security] 7 7

[Intrusion Prevention] % 7' .

# Cisco ASDM 6.3 for ASA - 10.86.94.88 L Ex
File View Took Wigsrds Window Hel Lack For: alial
ﬂﬂ-{.mﬂm [ PR Qs 7 v l cisco
o
v i | 8 e e (R ER Ei!-i
@"'LM":&HImeE‘l — theral ey +—@
el Barie Liceree Thevst Fpes Tasds Lt 7 s Lyt 00 s
(vt e, At ioryars, Pl Blockrg)
Mgrek [F- Lt Uipclats:
Fpepn Pl aares:
Ty Bl - Licaraad Meaa:
®_*:‘rﬂv— e Email 5uam +—@
™ Pt rast Pt sl
- 52 :..,.:-1- - - -ls-mi Tol:,;
i Plams reat. .. .
L : 1 nE nm=m 1 ] Peaitmal
:lu: . “s:.m TressFie SubgectiFRi R [ Serdies Conterk kon Megacon
S s
e ——r— o L] (] Hmmn:nmmn
JLA5]
GUIEXR & EA
1 [CSC SSM Information] ~31 >,
2 [Threat Summary] <X >, CSC SSM |Z & W #iH SN E M OENT — X 2 FKR L

FY, VANA AL U =T T4 NZ Y T ERIETT ey 7 SPUIZURL, 7
By SNIEANL TRy 7 ENET 7 A0, BEFEY—EARERHY £

D
3 [System Resources Status] <1 >,
4 [Email Scan] A1 >, 77 7\21%, 10 BRIRCT — ¥ BERINET,
5 [Latest CSC Security Events] <A1 >,

[Intrusion Prevention] & 7

[Intrusion Prevention] % 7 Cl%, IPSICEAT 2 HE R EMA MR TEET, ZDOX 7L, ASAIT
IPSEY a2 —NVNA VA= LI TWNELEEIZOHLFRINET,

IPS ¥ = —/VITHEHE T H121d, ROFIEZFATLET,
1. [Intrusion Prevention] # 7% 7 U v 7 L ¥ 7,
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. [Intrusion Prevention] % 7

[Connecting to IPS] XA 7 a2 77K v 7 ANERINET,
Connecting to IPS...

ASDM will make a new connection to the SSP-IPS module in this ASA system.
ASDM makes a separate connection to the IP address of the management port
on the 55P-1P5 module.

S5P-1PS Management IP Address: 10.89.147.143 Port: 443

Username:
Password:

| Save SSP-IPS login information on local host.

*Password cache is encrypted. Use File = Clear Password cache menu to clear it.

'S Y '8 N s Y Y
| Help ) [ Cancel (_ Continue |

255100

2. IP7FLA, A—h, 2—P—%, BIORRUY—-FEANLET, 74V DIPT
KLU AL AR—FME192.168.1.2:443 T, T 74V rDO2—F—ZB IO AT— i,
cisco & cisco T,

3. vl AU EHRE e — BV PCITRFT HITIE, [SaveIPS login information on local host] 7 =
IRy I A F AN LET,

4. [Continue] #7 VU v 7 LET,

RABEICEET 258MIc DWW TiX, TIPS 7 A v 7 A% — K HA K] 2B LTIEI,
WDKIZ, [Intrusion Prevention] % 712 % % [Health Dashboard] % 7 D EF %~ L £ T,
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asacxstatus] 2 7 [

6 : [Intrusion Prevention] 2 7 (Health Dashboard)

=T ] R

i | an

J cisee
L [ .. LY oo o | [ (il i | st o | “
;::::: : I_:-n_\.m_i il z ¥ T e ety (8 S Dbt
2 i AR IR .
B il 0 1o L Torwiems | v anraiE
& i) 18 ol g owbon: | LLEE ] B T ,n"/ \
i = T Sibel Lrord 400 1) R Pebraally I| |
1 PR e, LR - b o gl bt 8 2 A L} 8"'
| B one
| ¥
R g
= e U, 0 |20 AT
. B 0, 300 AL AMUTT
i L qrbde v Fand Dherded
et I'memmm
o 0w e 1,208 | UL
L b S e D
LB ﬁ
el EHE B 1625 T,
LY
GUI Zx BLL]
1 [Sensor Information] =1 >,
2 [Sensor Health] ~=- >,
3 [CPU, Memory, and Load] <31 >,
4 [Interface Status] <A >,
5 [Licensing] ~A1 >,

[ASA CX Status] % 7

[ASA CX Status] % 71Z1%, ASACX Y o — VAT HEERFERNFRINET, Z0OXT
1T, ASAIZASACX EV 2 — LB, VA =V ENTWBHRICOAERINET,
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. [ASA Firepower Status] % 7

ASDM 5574 AL A—H— (28 —Tz4R |

e
s sicelisbboitt ™ fusilRasiaaiy ~ s xesrans
|,
ﬂﬁ Device Information
Model: ASASSB5-55P-CX10
Hardware Version: 1.3
Serial Number: JAF1543CGRE
Firmware Version: 2.0(13)0

Software Version: 0.6.1
MAC Address Range: 70ca.9bf0.1cad to 70ca.9bf0.1cab

Last updated: 10:56:39 AM m Interface Status

Application Name:
Application Status:

Application Status Description:

Application Version:
Data plane Status:
Status:

Last updated: 10:56:39 AM
ASA CX Security Module
up
Normal Operation
0.6.1
up
up

H[EET

Connect to the ASA CX application:

https://10.89.147.153:443

[ASA Firepower Status] % 7

[ASA Firepower Status] # 7'(2i%, ZOEY 2 —/LICETHERAETRENE T, ZOFRIC
I, BTN, VUTNANEES, YT U T RXR=U g R0V a—NERE, TV r—
varg, TV r—vary AT —HA, T—H TL—r AT —H R BERORT—H AT}
EDETVa— )V AT —FZANEENET, £ =—/L FireSIGHT Management Center {28k
ENTWLEARIE, Vo2& 7Yy 7 LTT 7 r—yva &, SR oeEy 2 —b
DOEREEITHIZENTEET,

Z DX TV, ASA Firepower ¥ 2 — VN T N, ZTA VA =L ST DHEEITOHER
EhEd,

FireSIGHT Management Center Cli72 < ASDM % {# f] L T ASA Firepower ¥ = — /L ZEF B L
TWAELEIE, BoX TRFRSNET,

 [ASA Firepower Dashboard] : % v ¥ = h— RIZiX, Y 2— /L TETHOY 7 vy =7,
"]GDT7 v 7T —h, T4 T VAT LAOAR, T4 A7 DML AT LK
M, BLXOA v F—T 2 ADAT —Z AZONTOMBEFERPIBRENET,

« [ASA FirepowerReporting] : LA — MERO~R—121E, Web h7 2V | 22— — %[5

Jo. BV a—VEBUTCI I 74 v I BEEINDIFHLERE, SEIFEREY 2 —1ORG
W LT AL 10D v 3o — RBNRENET,

[Home] N1 > (R T L)

ASDM ¥ 2T A D [Home] A > Tld., ASAICBTAEER AT — X A EFREFRTE £,
ASDM ¥ 27 LD [Home] <A NNIFERSNDFHEMOIE L A L1, ASDM Ot dI5HTC 6 2
TEETH, ZOA U TILASADEMERELZ —H TR TE£7., v A7 LD [Home] <A
VDOAT—H AERIT 10 DEECTER S E T,

B ASMSS T4 AL aA—H—A28—T(R
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asomzznzs |

WO, AT 5O [Home] <A > DEFRZRLET,
7: AT LD [Home] XA >

® Cisco ASDM 6.3 for ASA | 171.23.204.65 | System

Fila whe Took Wigsrck Window | Help el .|h.||n
N L | e L L 7 e _l cisee
Dervice List BN | Home o
0 s ¥ s et aie 5ot e et
i pmm.u.au.u Ttatace = o eor L'Ili'dmm *'l Contaat Camachions ‘_®
H Em satteran e ||| |
@—)‘ g::,u sty 0 p
e e = s "
TR EE A GigubErEamatlf .Y porbed? s
L RTEN LR g LT T ) nla ;
B TSl [ w— 0 5
& P ol
o s Marsgemariiyh ml 9 .
o 0T L5 LB M (L5 )
CRET- S
B (7RI AL
ERLTaEES
CRIT R T ot e ‘—@
Ditgiwy: P o [ Fawreey Ui bibin y (FE0
B e 0} 2080 06
1 s ) P e
et : -
- - -
= Fetew wpdrrns = ﬂg E.‘a—*mnmm H
@
AR
GUIER £ BA
1 VAT LE T XA MOER,
2 [Interface Status] 1 >, A X —T7 = A AZBBTDH N T 7 4 v 7 ORI AETR
THINE, A F =T oA ZAEBIRLET,
3 [Connection Status] ~<A >,
4 [CPU Status] ~21 >,
5 [Memory Status] <1 >,

ASDM ;X ENDEE

FrE D ASDM BREDEEZ ERTE £7,
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B ssovzzozs

ASDM D S £ SERRELEL T DI2IE, ROFIEEZFATLET,

FIE

AT w71 [Tools] > [Preferences] DIEIZEN L £,

[General], [Rules Table]. 35 & O [Syslog] ® 3 2D % 7 D& % [Preferences] X A 7 1 7R v 7 A
MERINET,

ATY T2 BEEZEFRT DI, 60X TD12%27 U v 7 LET, [General] ¥ 7 CIZILHT Y 7 7
L A%4EE L. [Rules Table] # 7 CiX [Rules] 7T—7 VD7V 77 LU AE/ELET,
72, [Syslog] # 7 Cli%. [Home] <A NZEKRIILD syslog A v E—VDIMBLAZTRE LD |
NetFlow B D syslog A v —YDELE X v —VDFREA F—T VI LT TEET,
AT w73 [General] ¥ 7 Clx, ROEHEZRELET,

ARG =TT AT 4 Falb—vartETar 74 Xab—va VARSI LTHRN
EXITBAMIND L DT T 541, [Warn that configuration in ASDM is out of sync with the
configuration in ASA] F = v 7 Ry 7 A% AT LET,

o EENFFIC read-only 2 — Y — 2% L TIRD A v B— T %K RT 5845102, [Show configuration
restriction message toread-onlyuser] &= v 7 R v 7 A&E A NI LET, TOFT T3 U,
T 7N b THTY,

“You are not allowed to modify the ASA configuration,
because you do not have sufficient privileges.”

c AL —7 o=y MR SN2 — P —ITRERIRA v & —P %2 FRT 5I1T1E, [Show
configuration restriction message on a slave unit in an ASA cluster] = v 7 R > 7 A% 4 12

Liﬁ‘o

cASDM AU % &L IR THMERTH a7 IRFEREND X 91T 5121, [Confirm
before exiting from | F= v/ Ry 7 A% AN LET, ZOF T aid, 774/ KT
* T,

e AJ Y= U —H—% A 3—TWMIF HIZIX, [Enable screen reader support (requires ASDM
restart)] F = v VAR YV AZF T LET, ZOF T a a2 =TT DHITIE
ASDM Z fREEE 2 LB H Y £,

« ASA AEY OF/NEZEREN, ASDM 7 7Y r— g U OFEREREE FATT DI
+0THHEEITEMNEZ(ET HI1Z1E. [Warn of insufficient ASA memory when ASDM loads]
Fry IRy I ReA AT LET, ASDM L, BEIRFHZT F R b N — A vE—T A
FVEELZFIR L, ASDMDZ A L AR—=TFTF A MIA =V FR L, 24 2L
\Zsyslog 77— hEEE LET,

+ [Communications] fE# T :

s ASDM IZ X » TAR &5 CLI 2> REFRT HIZIE, [Preview commands before
sending them to the device] = v 7R v 7 A& F N LET,
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ASDM 5% 7€ D FE &

s ASAZBE D a~ L RE 15D 7 N—7¢ L TEET SITIE. [Enable cumulative (batch)
CLIdelivery] F= v 7 R v 7 2%+ 2 LET,

* [Minimum Configuration Sending Timeout] 7 4 —/V NIZZ A LT 7 k A v E—T DFEF
REDRERMEZEMNMTANLET, 774/ MI 60T,

eI F AT HANET— RO AT ATIX, [Graph User time interval in System Context]
74—V RIZ, [Home] <A D277 7 DOHEFMFOREH A 1 ~40 B OHPHTATIL
£9, T AN MTI10BTT,

* [Logging] 7B T :

e Java B X 2 V&R ET HIZ1E, [Enable logging to the ASDM Java console] F = v 27 7R
g AEF T LET,

s Ky 7 X UR MG [Logging Level] Zi&IR LT, v ET77 4 (EKE) Zi%
ELET,

* [Packet Capture Wizard] ik T, ¥ v 7' F ¥ Shi=X7 v M & FRT HITIL, [Network Sniffer
Application] IZ44 i & AJ19 570>, [Browse]l 227 Vw7 LTCT 7 A/ VAT LA THMHKLE
‘j‘o

* [SFR Location Wizard] f€3% C. ASA FirePOWER € = —/1 D —hNVERT 7 A V%A
VAR AT LA EE LET, BEINHEITICRN L CH AR Y /E X IADMERE £ o
TWORLENRDH Y F£7,

AT w74 [Rules Table] # 7' C, RDIEHZRELET,
« [Display settings] Ti%, [Rules] 7—7 /L CON—/VDFRFEEERETEET,

* Auto-Expand Prefix iX EIZFHESWTHBIEFH IRy NV —2 B —E R 47
VN IN—T%FKART BHIZIE, [Auto-expand network and service object groups with
specified prefix] = v 7 R v 7 A& AN LET,

* [Auto-Expand Prefix] 7 1 —/L RIZ, &7 5 & SICHBMICERT IRy b —2 %
OV =R AT V2T N IN—TDT VT 4 v I A AT LET,

Xy NI BIOY—ER AT VxS b IN—T DA NRN—LZDITN—T %
[Rules] 7 — 7 /WZFERT 5 2%, [Show members of network and service object groups]
Frv IRy I AA NI LET, Fov IRy I AR TOHREIX, TA—T472
IRERRSNET,

* [Limit Members To] 7 4 —/V RIZ, - THX Y NV B —ER A7z
NIN—=TDEEANNTLET, ATV b TNN—T A N=R3FKRIhDEEIC
3, B nHDO A L AR= IR ETRENET,

o [Rules] 7—7 MZT_RTCHOT 7 ¥ a3 »&FrT BHIZiE, [Show all actions for service
policyrules] F= > 7 AR 7 2R A NI LET, Z7OGHIE. Y~ =R RINE
75
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* [Deployment Settings] Tl%, [Rules] 7 — 7 /WIZERNEZ#EHT 5 & XD ASA OENELZ %
ETEET,
cHLWT 7 AU A NEHAT A EZIINAT T —7 V%27 U 79 5I21%, [Issue“clear
xlate” command when deploying access lists] &= v 7 Ry 7 A% AN LET, ZOF
FEIZED, ASA THRESINDT Z7EA UARNR, T XTOEMT KL ATk L CTHE
FIZHEHASIND L HITLET,

* [Access Rule Hit Count Settings] Tld, [AccessRules] 7—7 VDt v MIET v 75— T
LRELAZRECEET, by MUT, R — T EH S E T, BRI —
LDt v ML, [Access Rules] 7 — 7 JTIERTRENEE A,

s [Access Rules] 7—7 /L Ct v NENRHBMIZT v 77— bbb X H I3 D10
[Update access rule hit counts automatically] 7= v 7 R v 7 A& A A2 LET,

* [AccessRules] 7—7 /W2, b MEN T L FTHTHMEADBEMNTHEELET, A
Ml D& IE 10 ~ 86400 FH T,

AT v F5 [Syslogl] # 7 Clix, WOHEHZEELET,

* [Syslog Colors] I CiX, v E 77 1 (HKE) LT EITE R ERIRAZHE L,
A e —VRREDAL <A XA TEET, [Severity] 1 7 LIZiX, 2T 7 1 (HKNE)
V“*‘ﬂﬁﬁ%ﬁﬁﬁi(ﬁ%%fc‘: IR REINET, HEVET77 0 (EKRKE) LIV TAyE—

DOE B EITATRAELEET LI, ST 207 6%2 20 v 7 LET, [PickaColor]
&47D7T/7xﬁﬁﬁéﬂiﬁoﬁ@mfﬂ#@&f%&Uy&Liﬁo

o [Swatches] ¥ 7 C/NL v InLEERINL, [OK] 227 U v 27 LET,
*[HSB] # 7 TH, S, BOEEZEL., [OK]ZZ7 Vv 7 LET,
«[RGB] % 7 TR, ¥k, BOREZHEL, [OK] 227V v 7 LET,

SR gsyslog A v E—VET A E—TNMIT LRI BEETIHA v E—VORREARX—T

JUIZF HITIE, [NetFlow] 15 T [Warn to disable redundant syslog messages when NetFlow
action is first applied to the global service policy rule] &= v 7 R v 7 A% AN LET,

ATYT6 ZNH3ODHTOREEBE L% T, [OK]Z 27V v 7 UTEREZIRT L. [Preferences] ¥
ATl Ry AEHALTET,

GE) TV T 7 VOAREEAVCETIIATICT HT-O0NT, BEARIE conf 7 7 A /LT
RIESN, TORETY—7 27— a3 v ETEITHOZEOMD ASDM t v 3
PBRIHATEDL LTV ET, TARTOEELZGTT 5L, ASDM % i
T L2MERNH Y T,
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ASDM Assistant TDRH& .

ASDM Assistant TODH&E

ATy T
ATy T2

ATvT3

BEEA K1)

&

ATy T2

ASDM Assistant > —/L ClL, Z A 7|2 U7 ASDM OfFERAFIED~LV T Z2 MR L, R T
i‘a‘o

HHICT 7 ' 23 521X [View] > [ASDM Assistant] > [How Do 1 7] DIEIZERIRT 570y, A== —
/S—® [Look For] 7 4 —/L R BIREBEEREZ A LET, [Find] Kry 7FX 7 URXRMpb
[How Do 17] Z 38R L THZRZBM L £ 77,

ASDM Assistant /79 H1201%. WROFNEEZFEITLFE T,

FIE

[View] > [ASDM Assistant] % #4R L £,

[ASDM Assistant] <A1 B FERSIVET,

[Search] 7 1 — /L RIZHMBE T DIFWMAEASTILT[Gol 27 U v 7 LET,
BR X7 #S [Search Results] XA NZE RSN E T,

[SearchResults] 7 v arBEL O [Features]| ¥ 7 ¥ a VICFRRINDEEDI 7 %7 U v
L. iEfESE AFLET,

v I DAEIIE

[History Metrics] ~31 o ClE, & FE I ERFEHEROBIELZIRIFT H L O IZ ASA R ETE,
ASDMZEH L TENE VT 70T — 7 MR R TEET, BEA N v 724 X—T7 L
RN, BEHRTEDDIX) T A A LOFEHERIZIT T, BEA N v 7 &4 X—TVIC
T 5 &, ERIO 10 43, 60 /7. 12 Kef, 5 HEO#EH 7 7 72 R AR TEET,

JBIEA NV w7 ZRGET 2I2E, ROFIEEZFEITLET,
FIE

[Configuration] > [Device Management] > [Advanced] > [History Metrics] ##R L £ 7,
[History Metrics] ™A » INER S NET,

[ASDM History Metrics] 7= v 7 AR v 7 A% AN L TREEA N v 7 &4 RX—T7/IZ L,
[Applyl 27 U v 27 LET,
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B v&—rshcununa<or

HR—rShTUWAEWNav U R

ASA T fE/ R o~ RiZIFE A YT _XTASDM THAR— FENFETN, MEOa 7 4
Fal—raroavy RO—HIXZ TEAINLIGERHY £3, Znboa~vr RolxtA
Eldar 74 Xab—ra VT ZENTEET, FHMIC OV TIE, [Tools]>[Show Commands
Ignored by ASDM on Device] &M L CT< 72X\,

BASNLAIRTEHIATUE

WDFIZ, CLI A TEININTZSHE!

2. ASDM CEMEIImETERVWa~v L RO—&EE2 /R LET, ASDM CEHIN S o~
> RIZASDM O GUILIZ—BIFRRSNERFA, BrEHa~r FIEGULICERENE TN, K

LI TEFEHA,

5 R—brshTWWENITU FO—E

HR— kAT ENITY R ASDM D E{E
capture S ET,
coredump M SN ET, ZiE, CLIZHEAHL CORHFETE

i‘a‘o

crypto engine large-mod-accel

BHINLET,

dhep-server (k> RV Z—T4—

ASDM T, T _XT® DHCP $——Zxf LT 1

e ) DERED DT SIET,
gject PAR— FxF5Hh

established EHEINET,

failover timeout BREINET,

fips WA ET,
nat-assigned-to-public-ip RSN FET,

pager BAINET,

pim accept-register route-map

M X FET, ASDM Tl [List] 47> a U IETRE
CIR
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YR—rShTOENITY ROEE .

HR—brEShTWWVEWhvavw o R ASDM D ENE

service-policy global matchaccess-list 7 7 A CTfli Hl STV 255 13 A,
WIZHl =R LET,

access-list myacl extended permit ip any any
class-map mycm
match access-list myacl
policy-map mypm
class mycm
inspect ftp
service-policy mypm global

set metric EHINET,
sysopt nodnsalias \EHINET,
sysopt uauth allow-http-cache WA I NFET,
terminal BHINET,
threat-detection rate EHINET,

HhR—rEShTWEWNaTY FOEE

BFOFETay 7 4 Fal—va& ASDMICr— R LG, £ 2R — hxtgsto=
<~V KRH-TH, ASDMOERIEIZITHE L A, P HR— bSO a~y REFRT 51
IZ. [Tools] > [Show Commands Ignored by ASDM on Device] % #&4R L £,

HR— FRENDEHR L TGV Y TRy F TR

ASDM T, 255.255.0255 O L 912k L TW AW 7 Ry h =273 R—FEhTnE
Hh, TmEz2E, WIIFEHATEEEA,

ip address inside 192.168.2.1 255.255.0.255

ASDM CLI YV — )L THR— FINTWEWA VRS9 T4 T 1—H—
av >R
ASDMCLI Y —Wit, £ 2570 T 47 a—¥— o< FEYR— L TWEFTA, 1%
TIT A TR ENLELET B CLLa~ Y REANTH L [([yesmnol] DANZERT 5T

Ry IRFIRENETHS ADAFITR#HE S NLEE v, KEVT ASDM 1E, JRE DT E Z
A LT MLET,

W 2R~ L ET,
1. [Tools] > [Command LineInterface] Z &R L 9,
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B ssomcuyv—nook—rshTomns L2555 T 1—F—aT K

2. cryptokey generatersa 2~ K& AN LET,
T 74/ D 1024 B b RSA F—AR SN ET,
3. cryptokey generatersa =~ REZFHEAN L £,
VIR RSA ¥ —% E#HE L THAERT 20O TERL, ROTT—RRREINET,

Do you really want to replace them? [yes/no] :WARNING: You already have
RSA ke0000000000000$A key
Input line must be less than 16 characters in length.

%Please answer 'yes' or 'no'.
Do you really want to replace them [yes/no]:

SERROR: Timed out waiting for a response.
ERROR: Failed to create new RSA keys names <Default-RSA-key>

[AI3BESR
« [ASDM] A b, —HF— N ARMERIFZLEAED A~ RERETEET,

snoconfirm 47> a v NHBCLIa~y RIZoWTiE, CLIa~<y FANRIZZOF 7 3
VEERLET, RICHFHZRLET,

crypto key generate rsa noconfirm
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CORF2IAVMNEI, RKEVRAOARITRF 2 AV MNDSEMRTT, YV IBHRICODEXLTIE
. BERBRIBEFAT. ZEBRICTZ Y 77— DHD. UV IEOR-IHBEI/LTEThTWNS
BEFHDEITEEZCTELIEZD, HBLETHLEZNMREBDFTIDT, IEXLBABICDL
TIKETAIPMDRF AV M ESELESZL,



